What’s New in OpenText
Connectivity 15
What’s New in OpenText
Connectivity 15

www.opentext.com
NORTH AMERICA +800 499 6544 • UNITED STATES +1 847 267 9330 • GERMANY +49 89 4629
UNITED KINGDOM +44 0 1189 848 000 • AUSTRALIA +61 2 9026 3400
Visit online.opentext.com for more information about OpenText solutions. OpenText Corporation is a publicly traded company on both NASDAQ (OTEX) and the
TSX (OTC). Copyright © 2014 Open Text Corporation. OpenText and Open Text are trademarks or registered trademarks of Open Text Corporation. This list is
not exhaustive. All other trademarks or registered trademarks are the property of their respective owners. All rights reserved.

Contents
About OpenText Connectivity 15 ................................................................................. 3
What Is New in This Release ........................................................................................ 4
Products Included in this Release ........................................................................................... 4
Update to Connectivity EULA.................................................................................................. 4
Citrix Certification.................................................................................................................... 4
Microsoft Windows 7 Certification ........................................................................................... 5
Microsoft Windows 8 Certification ........................................................................................... 5
Migration Wizard for Exceed PowerSuite and NFS Client ....................................................... 5
Refreshed User Interface ........................................................................................................ 6
Security Enhancements .......................................................................................................... 8
Security Enhancement Addressing SSL Poodle Bug (CVE-2014-3566) .................................10
Exceed Changes ...................................................................................................................12
Xconfig ..................................................................................................................................17
Xstart .....................................................................................................................................19
Exceed XDK ..........................................................................................................................19
Local X Clients .......................................................................................................................20
OpenText Setup Configuration Wizard (Sconfig) ....................................................................21
OpenText Web-to-Host and Deployment Wizards ..................................................................21
Updated Event Monitoring Server ..........................................................................................23

Supported Environments and Compatibility ............................................................ 24
Supported Operating Systems (OSs) .....................................................................................24
Web Browsers .......................................................................................................................24
Language Support .................................................................................................................24

Installation, Upgrade, and Patch Notes ..................................................................... 25
Installation Notes ...................................................................................................................25
6.2 Upgrade Process for PowerSuite 14 and NFS Client 14 ..................................................25

Contact Information .................................................................................................... 27

About OpenText Connectivity 15
This section provides an overview of OpenText Connectivity Version 15.0. It is recommended that you
read the release notes before installing the Connectivity products.
Connectivity Version 15.0 includes the following products:
Product

Description

OpenText™ Exceed™

Exceed transforms your computer into a fully functional X Window server. It
®
lets you run and display UNIX applications (X clients) from a Microsoft
®
Windows environment. Exceed allows you to access environments such as
UNIX, Linux, VMS, X Window System, and IBM mainframes. Use Exceed on
your local computer to:


Access powerful applications and information running on networked hosts.



Establish simultaneous connections to different computers running X
clients.



Use an X window manager to display a familiar visual interface from your X
environment.

OpenText™ Exceed™
3D

Exceed 3D is an Exceed add-on that adds remote display capabilities for 3D X
Window applications. It provides support for the OpenGL-API to ensure that
those complex applications are rendered and displayed with the best possible
accuracy and performance. It leverages the accelerated capabilities of modern
graphics cards, and reduces operational costs by replacing expensive, highend UNIX workstations with cost-effective Windows PCs.

OpenText™ Exceed™
XDK

This X Window System Development Kit for Exceed enables developers to
port existing X applications from UNIX or Linux systems to Windows platforms
with minimum re-programming. Use of Exceed XDK reduces software
development costs and shortens development cycles.

OpenText™
HostExplorer™

This PC-to-host terminal emulator provides secure connections from a
Windows desktop to enterprise hosts, including IBM mainframes, AS/400s,
UNIX and Linux systems.

OpenText™ Secure
Shell

This client implementation of the Secure Shell protocol (SSH2) provides
additional security for the existing suite of OpenText Connectivity products, and
can be used to provide secure SSH tunneling for 3rd party applications.
Note: If you are installing or upgrading any Connectivity components that use
OpenText Secure Shell (also referred to as CSS), ensure that OpenText
Secure Shell Version 15 is installed.

Product

Description

OpenText™
Connectivity Migration
Wizard

This tool enables smooth migration from OpenText™ Exceed PowerSuite 14 or
NFS Client14 to OpenText Connectivity 15.

What Is New in This Release
OpenText Connectivity Version 15.0 includes new features and product updates in the following areas:

Products Included in this Release
OpenText Connectivity 15 contains the following products:







OpenText Exceed 15
OpenText Exceed 3D 15
OpenText Exceed XDK 15
OpenText HostExplorer 15
OpenText Secure Shell 15
OpenText Connectivity Migration Wizard 15

For more details about each product, see “About OpenText Connectivity” above.
The products may be purchased together or individually. The legacy OpenText Exceed PowerSuite is no
longer provided as a single installer, but is now a product bundle that includes NFS Solo 14, Exceed 15
and Exceed 3D 15. NFS Client is no longer provided as a single installer, but is now a product bundle that
includes NFS Solo 14 and HostExplorer 15.

Update to Connectivity EULA
A new end user licensing agreement (EULA) has been introduced with this release. When you install
Version 15 products you will be asked to accept the new EULA. These terms and conditions can also be
accessed at the following URL:
http://www.opentext.com/agreements

Citrix Certification
The following Connectivity 15 products have been certified through the Citrix
Ready certification program, for use with Citrix XenApp 7.x:




OpenText Exceed 15
OpenText HostExplorer 15
OpenText Secure Shell 15

The Citrix Ready designation is awarded to products that have demonstrated compatibility with Citrix
cloud solutions, particularly in terms of mobility, networking, virtualization, and platforms.

Microsoft® Windows® 7 Certification
The following Connectivity 15 products have been certified as compatible with
Microsoft Windows 7:




OpenText Exceed 15
OpenText HostExplorer 15
OpenText Secure Shell 15

Microsoft® Windows® 8 Certification
The following Connectivity 15 products have been as compatible with Microsoft
Windows 8:




OpenText Exceed 15
OpenText HostExplorer 15
OpenText Secure Shell 15

Migration Wizard for Exceed PowerSuite and NFS
Client
A migration wizard for OpenText Exceed PowerSuite and OpenText NFS Client has been introduced. This
wizard enables smooth migration from OpenText Exceed PowerSuite 14.x or NFS Client Version 14.x to
OpenText Connectivity 15.0 components, and replaces the Exceed PowerSuite product with the
component products.

The migration wizard will perform the following tasks:


Examine the current machine to determine if OpenText Exceed PowerSuite 14 or NFS Client 14
products are installed



Back up the existing settings and uninstall the existing product



Install the relevant OpenText Connectivity 15.0 package, using the settings that were backed up.



The migration wizard will install each sub-product with Typical options. If you have installed any subproducts, the migration wizard will install updates for these individual products.
Note: The migration wizard is provided as an MSI that can perform the product upgrade using
Microsoft System Center or other automated tools that support MSI files. The migration wizard and
product components installation can be done silently. Component product installers can be modified
using MST files (transforms).

Refreshed User Interface
The following user interface updates have been introduced:
UI Change

Details

Connectivity
Products

New OpenText Connectivity
branding and icons

All the Start menu icons and Metro desktop icons have
been re-designed and updated from 8 bit to 32 bit. See
below.

All

Complete redesign of the
Xconfig, Xstart, Xsession
wizards.

The Xconfig, Xstart and Xsession wizards have been redesigned with improved workflows and ease of use. The
list of browsable applications in Xstart has also been
updated.

Exceed

Rearrangement of the
Exceed context menu

The Exceed context menu may be accessed:

Exceed



from the Full Screen toolbar



from the Exceed taskbar by hovering over the
taskbar and right-clicking on the preview pane

Improved Windows 8
experience

Metro Desktop—Metro tiles have been used for all toplevel Start menu applications. Windows 8.0 uses folder
shortcuts in the Start menu.

All

Improved Windows 8
experience

Gestures—Windows 8 gestures have been mapped to X
events.

Exceed

Old Icons

New Icons

Old Connection Central

New Connection Central

Old Metro Desktop

New Metro Desktop

Security Enhancements
This section lists the security enhancements that have been introduced.

SSH Update
Item

Details

Encryption algorithms for data
integrity

AES CTR encryption for SSH connections. Key sizes are 128, 192
and 256 bits.

Message Authentication

Added support for hmac-sha256 and hmac-sha2-512

Key Exchange

Added diffie-hellman-group-exchange-sha256

OpenSSL Update
The following changes were introduced:




OpenSSL libraries are updated from Version 0.98za to 1.0.1L
–

67 new cipher suites available for SSL based connections (HostExplorer and HostExplorer
FTP).

–

Support for elliptical curve cryptography.

–

Uses the latest FIPS compliant libraries. Note that FIPS Only mode may now be configured
from a single location, in OpenText Setup Configuration Wizard.

–

Includes the latest security fixes / patches.

The OpenSSL implementation now allows FTP to be loaded by HostExplorer and still use FIPS mode.
OpenSSL enables OpenText Connectivity products, including HostExplorer, Exceed, Exceed
Connection Server, and HostExplorer FTP, to provide Secure Socket Layer (SSL) encryption,
authentication, and privacy to network communication over SSH and SFTP. It contains the necessary
cryptographic libraries for SSL/TLS, and is provided in the form of two DLLs, libeay32.dll and
ssleay32.dll. The workstation is not limited to using the default protocol to start the X Window client
on the server. It can use any other startup method, including REXEC, RSH, and RLOGIN.

Smart Card Support
Secure Shell 15 now supports smart card authentication. Users with PIV
(FIPS 201) or other Windows-compatible smart cards can now authenticate
using RSA public key authentication to UNIX / Linux servers.
For this public/private key authentication over SSH, the private key is stored
in a certificate on the smart card. After selecting the login certificate from the
smart card, the user is prompted for the smart card PIN. Once the PIN is
entered, the user is logged in to the Linux/Unix machine.

The public key corresponding to the key in the smart card certificate needs to be stored in the
.ssh/authorized_keys file on the Linux server, or in the location where the server expects to find the
public key for public key authentication.
Note: For extraction of the public key from the certificate, a 3rd party tool is used. After you install
the Smart Card driver on a Windows machine, the certificate is extracted from the card and
placed into the Windows certificate store.

Detailed Logging
Administrators now have access to additional information in the Exceed log. The following information
about X applications and their connections is logged:


Remote port, IP address, socket # connection



Initial data connection from X applications



Who closed the connection and error number indicating the reason for closing



Rejection of an X application request to connect to Exceed

Disabling insecure connection methods in Xstart
Xstart can now be configured to disable insecure connection methods. This setting prevents users from
selecting insecure connection methods from Xstart (REXEC, RSH, RLOGIN, TELNET, DECnet). This
setting should only be used if OpenText Secure Shell is installed, as it restricts the available
communication protocols to Secure Shell (SSH) and Local Applications. This user interface change may
be configured only by administrative users.
To configure the Method menu to show only secure methods:
1. Go to the following location:
ProgramData\Hummingbird\Connectivity\15.00\Global\Exceed
2. In GlobalExceed.ini, configure the following setting:
Always Use SecureShell=TRUE
As a result, the File > Startup > Method drop-down menu will list fewer options (Secure Shell and
Local Applications only).

Note: Xstart will use only OpenText Secure Shell as a secure connection method. If other,
insecure methods were selected previously, the application would connect using SSH and the
following warning would be displayed:
Only Secure Shell method is enabled

Security Enhancement Addressing SSL Poodle Bug (CVE-2014-3566)
If Secure Sockets Layer version 3 (SSLv3) protocol is enabled in client-server communication, an attacker
can attempt to exploit this vulnerability to intercept and decipher encrypted communications between the
client and server. In OpenText Connectivity 15.0, no SSLv3 connections initiated by Secure Terminal,
OpenText HostExplorer or HostExplorer FTP are vulnerable to the POODLE bug (CVE-2014-3566).
OpenText recommends that customers discontinue their use of SSLv3 and switch to TLS 1.0 for secure
client-server communications.
To ensure that TLS encryption is used in place of SSLv3:
1. Update your client software to the latest version for all affected products.
2. Change any client-side profiles that are currently using SSLv2 or SSLv3 to TLS 1.0.
3. Update any servers running SSLv2 or SSLv3 protocol to use TLS 1.0 exclusively.
Note: It is important to switch to TLS on the client and server at the same time to preserve compatibility.

Enabling Client-Side TLS
To update OpenText HostExplorer/ Secure Terminal Profiles:
1. Open Connection Central.
2. Right-click a 3270, 5250 or VT profile and then click Properties
3. In the left pane, expand Security > General, click the SSL/TLS tab. Under Security Options,
select SSL/TLS.

4. In the left pane, click SSL/TLS From the Version list, select TLS Version 1.
5. Click OK to save the profile.
6. Repeat steps 2 through 5 for each affected profile
To update OpenText HostExplorer FTP Profiles:
1. Open Connection Central or HostExplorer FTP.
2. In the General tab, note the connection type. If the connection type is not FTP – SSL/TLS Explicit
or FTP – SSL/TLS Implicit, do not make any changes. If the connection type is FTP –SSL/TLS
Explicit or FTP – SSL/TLS Implicit, click the Authentication Settings button (pencil icon). The
SSL/TLS Configuration dialog box is displayed.

3. Under SSL/TLS Version, select TLS Version 1.

4. If you are connecting to an FTP host with this configuration, select the Reuse SSL Session check
box, at the bottom of the dialog box.
Note: Some FTP servers may be configured to require data connections to use the same SSL
session created for the control connection. This dialog appears in the FTP profile properties,
when an SSL connection type is selected, and when the Authentication Settings button (Pencil
icon) is clicked. It also appears in the Quick Script Editor, when the user is creating or editing a
connection statement for the macro, selecting an SSL or TLS option for Security, and clicking the
Configure button next to it.
5. Click OK twice to save your settings.
6. Repeat steps 2 through 5 for each affected FTP profile.

Exceed Changes
This section describes the new features and updates introduced in OpenText Exceed:

Performance Enhancements (2D and 3D)
Performance type

Details

2D Performance
Improvements

Exceed now provides the following performance improvements:


Drawing engine has been optimized to provide faster performance of
drawing operations.



Modern (anti-aliased) fonts and modern (anti-aliased) lines/trapezoids are
faster.
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3D performance
improvement
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Exceed 15, build130, FPS

Exceed 3D has been optimized to reduce CPU usage for GLX applications.
Depending on the application, this may result in increased performance.
Performance improvements occur in situations where CPU is the limiting factor
(e.g. local X applications or a high speed network).

Touch Screen Support
Exceed now provides multi-touch input dependent on hardware and software support.
To enable or disable support for touch events, use the Exceed menu. Exceed provides the following multitouch options:

Option in the Exceed Menu

Details

Send Touch Events to X—off

All touch events are based on the Windows behavior. As a
result, Exceed and X applications receive the events as all the
other Windows applications. For example, if a Windows gesture
is interpreted by Windows 8 as a right-click event, Exceed will
convey this as a relevant Exceed event to certain X applications,
if applicable.
Note: Not all X desktop or X applications are multi-touch aware.
If you are using such applications, ensure that the option Send
Touch Events to X is deselected, and then let the Windows
system convert the touch events to mouse events.

Send Touch Events to X —on

Multi-touch input is recognized when the option Send Touch
Events to X is selected from the Exceed menu. Gestures that
you may use depend on the hardware and software support
(they are X application specific).
Windows Touch events, instead of Windows gestures, are sent
to X applications through Xinput Extension events. The
corresponding X gestures take effect, if they were defined by the
X application and/or the X Window Manager.

Full Screen Toolbar
Exceed now provides a Full Screen toolbar, for a quick and smooth access to Exceed menu and its tools.

The availability of the toolbar must be configured in Xconfig. The toolbar may be pinned to the screen,
supports the F11 toggle, and auto-hiding. It also allows you to minimize or restore a window, and close an
X Window session.
To enable Full Screen mode:
1. Launch Xconfig, go to the Display and Video settings, and select the Screen tab.
2. Under Window Mode, select Single.
3. Under Root Size (pixels), select the Full Screen check box.
4. Click Save. As a result, Full Screen toolbar becomes available in Exceed.

Features of the Full Screen toolbar:
Task

Steps

Toolbar Icon

Display the configured
Full Screen toolbar

Place the mouse cursor on the top edge of the screen. The
toolbar is displayed. Move the pointer away, and the toolbar
is no longer shown.

N/A

Toggle a Full Screen
toolbar in Exceed

Press the F11 button on the keyboard, to hide the Full
Screen toolbar. Press the button again, to redisplay the
toolbar.

N/A

Pin the toolbar to the
screen

Click the Pin icon on the toolbar. The toolbar remains on
the screen until you click the icon again, and is not hidden
once you move the mouse pointer away from the top edge
of the screen.

Display the Exceed menu

Click the Menu icon on the toolbar, and select the preferred
option.

Note: The availability of the View menu and its options
depends on a particular Window Mode and monitor
configuration.
Minimize the window

Click the Minimize icon.

Restore the minimized
window.

Click the Restore icon.

Close the X Window
session

Click the Close icon on the toolbar. You are prompted to
confirm whether you want to close the Xsession.
Click OK.

Detailed Tracing in Exceed
Generating a trace in Exceed now results in a zipped file that includes additional details. The following
information is provided:






trace
exceed.xcfg
exceed.log
keyboard files
Xstart file

This allows for easier reporting of issues to the OpenText Customer Support team and facilitates
troubleshooting.

Ability to Add Comments to a Trace
Users can now add comments to a trace, to facilitate troubleshooting.
To add comments to a trace:

1. From the Exceed Tools menu or Exceed Toolbar, select Trace Manager. A window is displayed,
enabling you to type the comment.
2. Click Insert, or press ENTER on the keyboard, to insert the comment you typed.

Xconfig
This section describes changes introduced in Xconfig.

New Resizing Policies for Single Window Mode
In addition to Fixed and Scaled, Exceed now allows Dynamic resizing of the root window and its contents.
Note: When launching Exceed in Single Window Mode on monitors that use different resolutions,
the root window uses the resolution of the smallest display. This eliminates the need for scroll
bars.
To configure Single Window Mode (SWM) resizing behaviour:
1. Go to Xconfig > Display and Video > Common Settings.
2. From the Resizing Policy menu, select the desired option.
Scaling Option

Details

Fixed

In this mode, a user (or the system) defines the size of the root window. By default, an
X session uses Fixed resizing policy. If you click the Maximize button in the toolbar, the
main window is restored to its original position and size.
Note: Scroll bars appear automatically, when a Fixed policy is in use. GLX applications
will be terminated when you switch from the Fixed to Scaled resizing policy.

Dynamic

Allows you to resize the window dynamically. The X application (such as the KDE
environment) will reflect this and fit in the new window. For example, you may switch
from Single to Multiple Monitor Mode (or vice versa). The X applications will renegotiate
the new root window size and be redrawn appropriately based on the new information.
They would not be distorted as it might happen in the Scaled mode. The minimum size
of the window has been set to 800x600. You cannot resize the window to be smaller.
When the window is maximized, the window and root window will cover the work area.

Scaling Option

Details

Scaled

When you resize the window, the size of the root window does not change, but the
contents of the X session scale up/down accordingly. For example, if multiple X
sessions are running, the user may view them as thumbnails. Scaling does not affect
the behavior of UNIX applications, because the root window size remains the same.
When you select the Scaled policy you have the following options:


Select Maintain Aspect Ratio—In this case, the contents of the X session scale so
that their original ratio is preserved, and the objects in the main window do not
appear distorted.



Do not select Maintain Aspect Ratio—In this case, the main window of the X
session and its contents will be resized, but their original ratio will not be
maintained, and the objects in the window may appear distorted.

Note: You cannot switch directly from a Scaled to Dynamic policy, or Dynamic to
Scaled. You must switch to and apply a Fixed resizing policy, before choosing Scaled
or Dynamic.

New Options for Monitor Selection in Xconfig
If multiple monitors are attached to your machine, you can use all of them, to display an X session, or you
can specify which monitors you want to use. The following options for monitor selection are now available:
Monitor Option

Details

Use All

Enables the use of all available monitors.

Use Primary

Enables the use of only your Primary Monitor.

Use all but Primary

Enables the use of all non-primary monitors.

Specified

Lets you specify which monitors to use. Type the monitor number in the adjacent
box. Up to 32 monitors are supported. To use multiple monitors, you must install
multiple video cards or a video card that supports multiple monitors on your
computer.

Note: In the Exceed View menu, the Switch Monitor option is available only in Full Screen mode, when
there are multiple screens available to the system. To switch screens while in Full Screen mode, click the
Exceed Menu button in the Full Screen toolbar, and select View > Switch Monitor.

Xstart
This section describes changes introduced in Xstart.

New Command Line Option to Specify Xconfig in an Xstart file
Feature

Details

Command line option
for specifying Xconfig
in an Xstart file

If Exceed is already running, the new command line is added when a new
instance of Exceed is called. Command line option is -o.
Example:
xstart -o single.xcfg -u testing -p testing -m telnet -h
hostname -c "xterm -display @d"

Exceed XDK
This section describes the changes introduced in OpenText Exceed XDK.


Most of the local X clients that were once in OpenText Exceed or OpenText Exceed 3D have been
moved to OpenText Exceed XDK.
–

32bit Local X Clients are provided in the bin folder.

–

64bit Local X Clients are provided in the bin64 folder.

To allow for proper redistribution of local X Clients built using the Exceed XDK the following
directories have been provided:
–

Redist32 – Runtime dlls for 32bit clients

–

Redist64 – Runtime dlls for 64bit clients

–

Resources – resource folder for local x clients

Please review the readme.txt files contained in the appropriate Redist folder to determine which
files you may need to include with your application.


OpenText Exceed XDK no longer supports MinGW. Previously, users of Exceed XDK could build
MinGW applications using the Exceed XDK environment.



OpenText Exceed XDK is now versionless. It is forwards and backwards compatible with all versions
of OpenText Exceed. This means that the Exceed XDK library (xlib.dll) now looks for the highest
version of Exceed on this computer, and starts it. The application will use the Resource environment
provided by Exceed. If Exceed is not installed on this computer, to allow the application to run you
must specify the display ID. The application will use the Resource environment provided by Exceed
XDK.

Local X Clients
Most of the local X clients, previously packaged with OpenText Exceed and OpenText Exceed PowerSuite
are now packaged with OpenText Exceed XDK. Some remain packaged with OpenText Exceed. Local X
clients in OpenText Exceed XDK no longer have individual icons. All the shortcuts for local X clients in
OpenText Exceed XDK may be accessed from a platform specific Local X Client Start menu shortcut.

Local X Clients in OpenText Exceed XDK
Exceed XDK now provides the Custom Setup option, during installation. Select Local X Clients or Local X
Clients Source. The latter option is not a prerequisite for installing Local X Clients.
To install local X clients:


Go to Start > All Programs > OpenText Exceed XDK > Local X Clients (32bit). If you choose this
option, 18 subfeatures are installed.
- or -



Go to Start > All Programs > OpenText Exceed XDK > Local X Clients (64bit). If you choose this
option, 17 subfeatures are installed.

Without Exceed installed, the local X clients cannot be launched because humprdex.dll is not present.
The user needs to install Exceed XDK with an Exceed product that contains humprdex.dll if they want
to run the local X clients.

Local X Clients in OpenText Exceed
The following local X clients are now packaged with Exceed:
Feature

Binary

Kinput2

Kinput2.exe

Feature

Binary

Hwm

Hwm.exe

Input2Magellan

Input2Magellan.exe

OpenText Setup Configuration Wizard (Sconfig)
This section describes the changes introduced in OpenText Setup Configuration Wizard.

Enabling FIPS Only Mode
Using OpenText Setup Configuration Wizard, you can enable or disable FIPS compliant ciphers and
encryption from a single location. Once the FIPS only mode is enabled, it becomes the default mode. To
ensure that only FIPS mode is enabled configure the following option in the Properties section of the
OpenText Setup Configuration Wizard:
Security.UseFIPSOnly

OpenText Web-to-Host and Deployment Wizards
This section describes the changes introduced in OpenText Web to Host and Deployment Wizard, which
allows you to create Web-deployable installations of certain OpenText Connectivity products.
Note: 64-bit versions of Windows require deployment of the 64-bit version of Connection Central
and HostExplorer FTP.
Note: Profiles used in Web Deployment should be saved prior to building a new Web Project. The
following changes have been introduced:
Feature

Description

HostExplorer x64 can
now be deployed in
Internet Explorer (Java
only).

HostExplorer x86 can be deployed in IE using ActiveX or Java. When ActiveX is
not available, a fallback to Java has been added.

Support for modern
browsers

Version 15 supports modern browsers, such as the latest Firefox and Chrome
with Java plug-in/add-on enabled.

Feature

Description

Improved error
handling

Updated error messages for an OpenText Component Deployment now provide
more contextual information, depending on a browser configuration. For
example, the error message may inform you that:

Web Deployed Printer
Profile is now viewable
outside of the browser.



There is an attempt to download the OpenText Component Deployment
Active X Control. You are reminded to enable any security options
necessary in your browser to permit this.



The Protected Mode is detected. You cannot proceed until the mode is
turned off.



Java is required but not installed. You are prompted to install it.



You are running a browser that works with the deployment but that has
neither Java nor Active X control support available. You are provided with a
download link.



Product deployment is complete and the browser window may be closed.

Web Deployed Printer Profile is now viewable outside of the browser. The
browser may be closed.
To achieve this for the Version 15.0 printer profiles:
1. Launch Host Explorer Web-to-Host Wizard, and display the following
dialog box: At the Auxiliary Files and Web-to-Host Settings.
2. Under Display Options, select HostExplorer Window, so that it defaults
to Window instead of an ActiveX object.
Note: The ability to change a window size in an ActiveX Object case is still
available.

Updated Event Monitoring Server
OpenText Connectivity products include a built-in compliance and usage tracking mechanism. Using
Event Monitoring Server and Event Monitoring Client, administrators can track the use of OpenText
Connectivity products.
The Event Monitoring Server for OpenText Connectivity 15.0 products is now compatible with:


Internet Information Services (IIS) 7 and 7.5 for Windows® Server 2008 and Windows 2008 R2



MSSQL 2005 and later
Note: The supplied script hems-create_database-mssql.sql for SQL Server requires a full
path to the database files. Ensure that this full path is specified.

Supported Environments and Compatibility
This section provides details about supported platforms, systems, and versions.

Supported Operating Systems (OSs)
This section lists the operating systems supported by Connectivity 15 release.
Operating System (OS)

Details

Affected Connectivity 15 products

Windows® 8.1 Enterprise (32-bit and 64-bit)

Certified

All

Windows® 7 Enterprise (32-bit and 64-bit)

Certified

All

Windows 8.0 Enterprise (32-bit and 64-bit)

Supported

All

Windows Server 2008 R2 (64-bit)

Supported

All

Windows Server 2012 R2 (64-bit)

Supported

All

Windows Server 2008 R2 with Terminal
Services / Citrix XenApp

Supported

All (Except Exceed XDK)

Windows Server 2012 R2 with Terminal
Services / Citrix XenApp

Certified

All (Except Exceed XDK)

Web Browsers
This section lists the browsers supported by OpenText Deployment Wizard.
Browser

Details

Internet Explorer 11
Mozilla Firefox

Note: 64-bit IE only supports Java deployment. 32-bit IE supports
ActiveX with Java fallback.

Google Chrome

Language Support
OpenText Connectivity is currently localized in the following languages.
The user interface is available in the following languages: English, German, French, Italian, and Spanish.
Online help is provided in English only. Future releases may add additional languages.

Installation, Upgrade, and Patch Notes
This section provides additional installation and upgrade information, including related or third-party
product information and any required critical patches.
Note: OpenText Secure Shell Version 14 and earlier are not compatible with Version 15 products. When
migrating your Connectivity software to Version 15, please update OpenText Secure Shell to Version 15.

Installation Notes
Before you install OpenText Connectivity products, review these additional installation notes and verify
related product or third-party product requirements.
See OpenText Connectivity Installation and Administration Guide for more details.
To install OpenText Connectivity Version 15.0:
1. Visit OpenText Knowledge Center: https://knowledge.opentext.com/
2. Locate the OpenText Connectivity page for downloads, and the OpenText Connectivity
installation packages.
3. Download the installation package/file for the product you want to install. Both 32 and 64 bit
versions are available. You can download:


a product ISO file which can be mounted or burned to physical DVD media. For example,
OpenTextExceed15.iso



a DVD ESD self-extracting executable file which will expand the DVD contents (including
msetup.exe) to a folder on your computer.

4. Once you have access to the DVD folder tree, run the msetup.exe to continue the installation
process.
5. Follow the on-screen prompts, to complete the installation.

6.2 Upgrade Process for PowerSuite 14 and NFS Client 14
This section provides the upgrade instructions. For more details, refer to the OpenText Connectivity
Migration Wizard Guide.
To upgrade (migrate) the OpenText Exceed PowerSuite or NFS Client (from Version 14.0 to Version
15.0):
1. Visit OpenText Knowledge Center: https://knowledge.opentext.com/
2. Under Product > Downloads, search for the relevant download folder.

If you are upgrading from…

Do this…

Exceed PowerSuite 14



Search for Exceed Family-Downloads, and then click Exceed
PowerSuite Download.



Open Exceed PowerSuite 15 folder, and then open the Connectivity
Migration Wizard folder.



Search for Network File System (NFS)-Downloads, and then click
NFS Client 15 Downloads.



Open NFS Client 15 folder, and then open the Connectivity Migration
Wizard folder.

NFS Client 14

3. Download the ConnectivityMigration.zip file, and extract the following file contents:
Extracted Item(s)

Details

Files

UpgradeSetup.exe
CA_FSTWIZARD.exe
Setup.ini

Target Folders/Directories

\Exceed
\Exceed 3D
\HostExplorer
\NFS Solo v14

4. Double-click UpgradeSetup.exe, to launch your OpenText Connectivity Migration Wizard. The
Welcome page is displayed.
5. Click Next, and then follow the on-screen prompts.
6. For more details, refer to the OpenText Connectivity Migration Wizard Guide.
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